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Background 
This manual explains proprietary software that communicates with the printer system through two linked software applications – Create and 

Control.  

• Create is used to design messages. 

• Control manages the production line setup/control, message selection/management, delays, security and more. 

• NOTE:  Both software packages may be run on a PC or industrial HMI.  

Download the printer firmware and software and install it on a PC that has access to a production line and/or an HMI located at the production 
line. (Contact Technical Support for the latest firmware and software downloads and instructions). 

 

Software Installation 
Pages 10-13 show typical 1 and 2 printer configuration references. See “Adding Secondary Printers” and “Bump Turn (Multi-Zone) 

Configurations” for non-typical configurations. The “Configuration References” detail how the hardware and software are to be configured for a 

successful installation: 

• Physical Setup of printer(s) on a conveyor production line* 

• Power and communication connections* 

• Control setup screen 

• Create Message   

*More information on the physical setup and connections is provided in the Printer System Manual (400386) located on the USB drive that comes 

with every printer. 
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Definitions 
 

Advanced Barcode GS1 (Global Standard) barcodes can include special identifiers that are added                  

Data:   to barcodes following a strict set of rules. This is an advanced feature. 

Barcode Type: Types of barcodes include – ITF-14, UPC-A, UPC-E, EAN 13, EAN 8, I2 of 5, Code 128, GS1-Datamatrix, Datamatrix, QR 

Code, GS1 QR Code and GS1-128. Each barcode type has specific settings. 

Bleed Factor: Barcode term to explain how much printed ink spreads on a substrate. Set as default to zero, this may be adjusted to 

compensate for barcode print quality. Some carton materials are less porous than others and the printed ink on the carton 

may not spread as much as standard Kraft style cartons. Note: Barcode verification may fail for non-standard x-dimension 

widths. Recycled carton materials can cause unwanted bleeding requiring adjustment. 

Bundle: Create or Control software can create a group of all messages and the data fields within them into a single file. Bundles 

can be created from existing messages or imported to production line printers or the Local PC.  

Character Width: Refers to the aspect ratio of a font. Default character width is set to its font size but may be modified after unlocking the 

aspect ratio. Characters may be modified to a narrower or wider version of the original font.  

Data Fields: Message data that is dragged and dropped onto a print area. Types include: Text, Graphic, Barcode, Line, Rectangle, Date 

& Time, Counter and Variable.  

Diagnostics: Troubleshooting tool that creates a single file that is used by product developers to identify printer specifics. 

  

Ink Usage: A Create feature that estimates the cost and number of prints per message. It is accessible by clicking on the ellipse menu 

in the upper-right hand corner of the Create home screen.    

Left Margin: Distance from the left edge of the product carton and either start or end of print, depending on conveyor direction.  

Length: A variable value in the Create message tab. Typically equal to the total length of the product. 

Line: Production Line. This refers to all printers connected together. Referenced when saving or accessing a message in Create 

and primary printer in control. 

Local PC: This is referenced when saving or accessing a message. This may be an HMI or Networked PC. User will be prompted to 

select a folder location. 

Message: Contains between 1-8 print areas of which are populated with data fields. Messages saved to the production line are saved 

to all primary and secondary printers. 



 
400463 Rev C Software Manual                                                         P a g e  7 

 

Barcode Module: 2D barcode term for the size of the entire code measured in black + white squares in the horizontal direction and black + 

white squares in the vertical direction. i.e., 21x21. 

Offset Type: A Date & Time data field option that advances the message and printed data in days, weeks, months or years from the 

actual date. Time fields do not have this feature available. 

Printer(s): Consists of a 2 inch or 4 inch Printer Module (PM) and coupled Ink Supply Module (ISM). 

Primary Printer(s): Printer identified as the one with a photocell connected to it and identified by “1” in the Control setup screen.  

Production lines may have up to 2 primary printers in a Multiple Zone setup.  

Multiple Zone setup is an advanced feature. 

Communication to ALL other printers go through the primary(s). 

All messages reside on the primary printer. 

Insert a USB Drive into the primary to upgrade firmware or download bundled messages.  

Print Area: Refers to either a 2 inches tall or 4 inches tall area in which the message is created. The print area length is set in the 

layout tab. Different printers may print the same print area. 

Quiet Zone: The area around a barcode that is blank. The GS1 standard sets the specific values for each type or barcode but Create 

software allows modifications. Note that barcode verification may fail for non-standard quiet zones.  

Retrieve Custom  Customized shift and user codes entered in Control may be retrieved in Create to populate variable fields in 

Codes:             messages. 

 

Right Margin: Distance measured from the right edge of the product carton and either start or end of print, depending on conveyor 

direction.  

Secondary Any printers connected to a primary printer.  

Printer(s):                 There may be up to 7 secondary printers, identified as “2, 3, 4, 5, 6, 7, 8” in the Control setup screen. Messages reside on 

all printers – primary and secondary.   

 

Print System:  Consists of a printer(s), cables, HMI, and other peripherals. 
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Variable Type: Variable is a data field that has multiple types including: 

Prompt  Before the message prints, the user is prompted to enter the data for that field. This occurs one time and 

from then on all subsequent messages will print the same prompted data entry. 

COM Port    Field data is supplied by a COM Port input such as from a scanner. This is an advanced feature. 

   Data Source   Origin point for data used in the Database feature. 

Database  Field data is supplied by a linked database. This is an advanced feature. 

X-Dimension: Barcode term referring to the width of the thinnest vertical bar in a barcode. Printers can print a minimum of a 0.010” 

wide bar. 

(x) Value: Refers to the distance a data field is located from zero in the x-direction (left-right). Units are in centimeters or inches. 

(y) Value: Refers to the distance a data field is located from zero in the y-direction (up-down). Units are in centimeters or inches. 

Print Zone: There can be one or two zones on a production line. Each zone has its own primary printer. Two zones are required when 

conveyor speed changes between printers and/or a change in product travel direction such as a bump-turn application.   
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Installation Considerations: 
*As you proceed through this manual consider the following important questions and decisions that have to be made for a successful 

installation.  

 

How many printers are in the system? 

Is there an HMI on the production line? 

Determine if communication to the primary printer(s) and optional HMI will be wired or wireless. Options are: 

o Wired to the HMI 
o Wireless to the HMI 
o Wired to the Primary printer(s) 
o Wireless to the Primary printer(s) 
o Wired between Primary and Secondary printers 

Determine one or two zones are in the application by answering the question: Is there a change in product direction or conveyor speed?  

If NO, this is a ONE – ZONE application 

If YES, this is a TWO – ZONE application 

Determine which printer(s) will be primary. Which will be secondary? 

Determine the type of encoder that will be used: Internal (fixed) or External (variable) 

Determine if the photo-sensor will be mounted on the primary(s) or mounted on a bracket up the production line  

Assign each printer to a print area of the message being printed 

Create a message that matches the physical production and Control setups 

 

*  The next four pages give example applications for one and two printers. 

Note the matching physical setup, the Control setup and the Create message. 
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FILE Screen 

NEW MESSAGE 

Screen 

Advanced feature, See table of contents 

Save messages to an HMI, networked PC 

and/or primary printer 

Ellipse Menu 

Toggle: pan/select 

box 

Message name 

Message box for Print Area 1 

Touch here to 

expand menu 

Message Fields 

(can be hidden) 

Message box for Print Area 2 

Zoom to extent 

Create a 

message 
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Print Area 1 is 2” 

tall (Mark 2) 

 

Print Area 2 is 4” 

tall (Mark 4) 

EDIT 

CONFIGURATION 

Screen  
(inside the File tab) 

Where the message is 

printed 

Create software version 

OPEN FILE 

Screen  
(inside the File tab) 

Open messages 

stored on a 

networked PC or 

HMI on the 

production line 

Touch this row to 

open messages 

stored on this  

printer  

 

FOR EXAMPLE ONLY: 

Showing a primary printer 

already attached.    
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Used for troubleshooting, this creates a “.zip” file of a line 
configuration. 

Calculator that reports number of prints per ink cartridge and cost per print  

configuration. 

Select files and/or folders of “.next” message files to be shared  

Select where shared files are to be stored: Networked PC, HMI and/or primary 

printer  

Crete an image (“.png”) file of the message to save in the selected location.  

Changes to Shift and User codes inside Create are updated and propagate 

to Control.  

Ellipse Menu 
(Located in the top 

right-hand corner 

of the main screen) 



 
400463 Rev C Software Manual                                                         P a g e  17 

 

Creating a message 
 

• There are 8 different message fields: Text, graphic, barcode, line, rectangle, date & time, counter and variable. 

• Each message field has pull down tabs that contain functions that vary the base field. 

• Each field and tab is explained below. 

 

Text Fields 
 

 

 

HOME Tab 
• Cut, Copy, Paste & Delete functions. 

• (x) Value refers to the left - right direction from the top-left corner of the field. 

• Use up/down arrows to increment at 1/64”. 

• Highlight the 1.833 inch value to type in a new numeric value. 

• This value may be expressed in millimeters (mm) by changing the Windows regional settings. 

• (y) Value refers to the up – down direction from the top-left corner of the field. 

• Use up/down arrows to increment at 1/64”.  

• Highlight the 0.384 inch value to type in a new numeric value. 

• This value may be expressed in millimeters (mm) by changing the Windows regional settings. 

• Pressing ENTER in the Data entry line will create a paragraph field. 
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FORMAT Tab 
• Cut, Copy, Paste & Delete functions. 

• Font down arrow may be any of the standard Windows fonts. 

• Font style variations include Bold, Italic and Narrow. Not available on every font.  

• Font size and Character width are optimized for print quality. Range: 8 - 255. 

• Font size must be chosen from the dropdown list. Cannot customize the size. 

• The aspect ratio is by default locked      but may be unlocked.  

• The Font size does not have to equal the character width. 

•      Inverts The bounding box of a text field white characters on a black background. 

• Alignment and Line spacing is only functional when a paragraph field is entered in the data entry line. 

• The field may be rotated, set to draft mode (resulting in lighter print), flipped horizontally or vertically. 

 

 

 

 

LAYOUT Tab 
• At left: Bring to Front, Bring Forward, Sent to Back, and Send Backward functions. 

• Center: Draw a window around multiple fields in a message to activate the Justification tools. 

• Right: Multiple fields may be Grouped or Ungrouped. 
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MESSAGE Tab 
• Same tab for all fields. Settings made here communicate with Control, dictating print location on a product. 

• Length: represents the length of the printed message and horizontal dimension of the product.    

• Use up/down arrows to increment at 1/64”.  

• Highlight the 10 inch value to type in a new numeric value. 

• This value may be expressed in millimeters (mm) by changing the Windows regional settings. 

• Width is not used 

• Right & Left Margins 

• Use up/down arrows to increment at 1/2”   

• Highlight the 0.000 inch value to type in a new numeric value 

• This value may be expressed in millimeters (mm) by changing the Windows regional settings. 

• Check the box to Print this many times and stop.  

• Check the box to set the Distance between continuous prints. 

• DPI or (Dots per Inch) sets the horizontal resolution for the message. The choices are 100, 150, 200 & 300. 

• The vertical resolution is fixed at 192 DPI due to the printer design. 

• 300 DPI = highest quality and darkest images.  

• Individual fields in a message cannot be set to different DPIs. The entire message is set to a specific DPI. 

• If a barcode is part of the message, Create will set the default DPI to 300. This can only be modified to 200. Only barcodes of 200 & 300. 

DPI can be verified successfully. 
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Graphic Fields 
 

 

 

 

HOME Tab 
• See “Text Fields” explanation for left and center sections above. 

• Click          to import an image. 

• Image must be of the following format: “.bmp”, “.jpg”, “.png” 

• File size: Less than 100KB typically. Large graphics can be printed by multiple printers. 

• File color: Grayscale  

FORMAT, LAYOUT & MESSAGE Tabs 
• See “Text Fields” explanation for these tabs. 

 

Line & Rectangle Fields 

 

HOME Tab  
• See “Text Fields” explanation for sections above. 

• Stroke Weight is the width or thickness of the line - minimum of 1/64” 

FORMAT, LAYOUT & MESSAGE Tabs 
• See “Text Fields” explanation for these tabs. 
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Counter Fields 

 

 

 

HOME Tab  
• See “Text Fields” explanation for two left sections above. 

• Count fields are whole numbers and may be incremental where Start count < End count OR decremental where Start count > End count. 

• Count by is a whole number lying between the start (1) and end counts (999999). 

• Check the box to add a Pallet Count feature to the counter.  

• In the Home tab example above, setting an items/pallet count to 2 means that the first two prints would print “000001”, the third and 

fourth prints would print “000002” (counting by 2s). 

• Print Leading Zeros is active by default. Unchecking this box would print “1” for the first two prints and “2” for the next two prints., etc. 

until 999999.  

• Alpha count is not active by default. Checking this box would print “A” for the first two prints and “B” for the next two prints, etc. until 

ZZZZZZ. 

 

FORMAT, LAYOUT & MESSAGE Tabs 
• See “Text Fields” explanation for these tabs. 

Date & Time Fields 
 

 

 

 

 

HOME Tab  
• See “Text Fields” explanation for two left sections above. 

• The Format data line has a drop-down menu featuring many standard formats with a Preview of the data below it. 

• Text may be typed into the Format data line before the date and/or time code. For example: “Best By:” 
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• Clicking        opens a Custom Time & Date windows with more selections for Date, Time, User and Extended as shown in the four windows 

above. 

• Clicking        will add the custom code to the Format data line drop down list. If a particular custom code is not listed it may be entered 

following the same format as the examples listed. 

• Offset Type options are Days, Weeks, Months and Years. The Offset value is a positive whole number. 

• User or Shift codes may be added to a message and draws upon Date & Time fields that have been inserted into a message. See User and 

Shift Fields later in this manual. 

 

FORMAT, LAYOUT & MESSAGE Tabs 
• See “Text Fields” explanation for these tabs. 
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Variable Fields 

 

 

 

HOME Tab  
• See “Text Fields” explanation for two left sections above. 

• Variable Type defaults to Prompt. Three other selections are available from the drop-down list: COM Port, Data Source and Database. 

• Prompt variables ask the user to enter data prior to the first print. Data is typically entered via pop-up keyboard on the HMI at the 

production line.  

• The default Length of the field in the example above is 10 characters displaying on the message as ten “W”s. 

• COM Port variables require a RS-232 serial port communication from a device such as a barcode scanner. 

• Database and Data Source variables – Learn more by reviewing the “Database (Inside the Create ellipse menu)” section below.   

FORMAT, LAYOUT & MESSAGE Tabs 
• See “Text Fields” explanation for these tabs. 

 

Barcode Fields 
 

 

 

 

HOME Tab  
• See “Text Fields” explanation for two left sections above. 

• Barcode types include: ITF-14, UPC-A, UPC-E, EAN-13, EAN-8, I2 of 5, Code 128, GS1 Datamatrix, Datamatrix, QR Code, GS1 QR Code, and 

GS1-128. 

• Data entry line may consist of: Numeric or Alpha-Numeric characters depending on the allowable data dictated by the Barcode type. 
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• Clicking       will open an Advanced Barcode Data window. 

• Clicking       on the right side of this window will allow a New Barcode Field to be added.  

• See Text Fields, Counter Fields, Date & Time Fields and Variable Fields field explanations above. 

• The Advanced Barcode Data window will only show compatible fields based on the Barcode Type (some barcodes only allow numeric data or 

a specific amount of digits). 

• Fields added to the Advanced Barcode Data list are printed in succession from top to bottom. 

• Fields may be edited or deleted, but not reordered. 

• X-Dimension is the technical term for the thinnest bar width in a 1D barcode or the square pixel dimension in a 2D barcode. There are only 

preset values available. 

• Quiet Zone is the blank area around a barcode that isolates barcodes from other fields that would normally interfere with barcode 

verification. 

• Bleed Factor is a proprietary feature that compensates for substrate porosity. Ink droplets print smaller on non-porous substrates, requiring a 

possible increase in bleed factor whereas ink droplets soak into porous substrates, requiring a possible decrease in bleed factor.    

• Print samples testing is required to optimize bleed factor. Default bleed is set for optimum quality while printing on brown, 30% recycled 

content Kraft paper. 
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• The printer can print GS1 (Global Standard) and non-GS1 barcodes.  

• GS1 barcodes contain Application Identifiers (A.I.) that are added in the Advanced Barcode Data window. 

• Each A.I. has a specific valid format. Create monitors data entry to ensure an accurate code. 

• Available A.I.s are displayed on a scrolling list.   

 

 

FORMAT Tab for UPC-A, UPC-E, EAN-13, EAN-8, Code 128 and GS1-128 
• See “Text Fields” explanation for left section above. 

• Human Readable characters may be required in some barcodes, selected for display or not for some barcodes OR not allowed in others. If 

allowed, Font Size and Style may be selected as explained in the TEXT tab above.   

• The Height of the barcode includes the human readable data as well as the 1D bars. 

• The Check Digit for the code is to be Autogenerated by default but may be unchecked and calculated manually and entered as part of the 

Advanced Barcode Data entry.  
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FORMAT Tab for ITF-14 and I2 of 5 
• See Format Tab above for explanation for the two left sections above, the Height and Check Digit. 

• Ratio is the technical term for the measure of wide bar to narrow bar. Allowable range is 2.25 - 3.00: 1 

• I2 of 5 barcodes require Vertical Bearer Bars but ITF-14 is unique in that it allows the code to be formed with or without them.  

• If Vertical (bearer bars) are part of the code, the width of them as well as the width of Horizontal (bearer bars) are set.   

• Bearer bar values may be expressed in millimeters (mm) by changing the Windows regional settings. 

 

 

 

 

 

 

 

 

FORMAT Tab for QR Code, Datamatrix, GS1 QR Code and GS1 Datamatrix 
• Encoding options are ASCII, C 40, Text, X 12, EDIFACT, Binary and Best. 

• Code Page options are None or UTF-8. 

• Size refers to the number of modules in the (horizontal) x (vertical) or 18x18 in the image above. 

• QR Code and GS1 QR Codes are square in shape. 

• Datamatrix and GS1 Datamatrix may be square or rectangular in shape.   

 

LAYOUT & MESSAGE Tabs 
• See “Text Fields” explanation for these tabs. 

 

 



 
400463 Rev C Software Manual                                                         P a g e  27 

 

Control - Screens in Control 
* Before opening Control, confirm that the physical hardware is connected exactly like one of the configurations on pages 8-11.  

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Inspect the rear of every printer and note the four-character ID.  
 

• The printer at left is: 0075 (last four characters of the MAC address) 
 

• The user chooses which printers will be PRIMARY and SECONDARY.  
 

• Follow one of the configurations on pages 8-11.  
 

• Other configurations are available such as Multi-Zone (Bump-turn) or 
Adding Secondary Printers and are detailed at the end of this manual.  

HOME Screen 
(no printers connected yet) 

Ellipse menu 

Hamburger menu 
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• Touch the Refresh icon for an automatic search of the network. 

• Can Manually search or perform a First Time Setup 

• Each printer has a fixed IP address for wired and wireless connections based on the MAC address.  

• For further information on these IP addresses please contact Technical Support Group. 

    

 

CONNECT Screen  
(inside hamburger menu) 0075 is the selected 

primary printer  

with good connection 

System Date & time 

0028 is another primary 

printer on the network 

available for connection.  

Printer Date & time 

Refresh 

connection 

IP Addresses  
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SETUP Screen  
(inside hamburger 

menu) 

 

 

 

• Inside the Zone Details card, the encoder type must be set to either External or Internal.  
o If Internal encoder is selected, the user must enter a conveyor line speed.  

• Print Direction must be set to either Left to right or Right to left. This is the equivalent to product travel direction. 

• Inside the Printer card the printer type is automatically identified by the software. This cannot be changed.  
 

• Distance from Photo-Sensor defaults at 2.000” when the photo-sensor is mounted on the printer. The photo-sensor may be mounted up the 
line, before the printer but the distance between it and the center of the printer must be modified to match. 
 

• Print Area. 0021 is a 2 inch printer meaning that it can print up to 2 inch tall. The message being printed must also be 2 inch tall in Print 
Area 1. 
 

• The printer can be set to print the entire message upside down. 

Printer card 

Zone Details card 

Save the 

setup 

Touch to Add 

a Zone 
This graphic indicates: 

• 0075 is a primary printer 

• Print Direction is left to right 

• Photo-sensor is offset 2”  

       from the printer 
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MESSAGES Screen  
(inside hamburger menu) 

 

 

 

 

 

 

 

 

• The “.next” messages above are located on the 0020 printer. 

• New printers only have the root folder “ / ”, but other folders may be added by touching the Add Folder button.  

• Touch the Add Messages button searches the Networked PC or HMI for messages residing there. Those messages can be loaded onto the 

primary printer, adding to this list. 

• Start Dataset Message. Messages may be populated from a database, and the template that is populated is also defined in the database. 
A SKU number in a database is scanned or entered and the software launches a predefined template and populates it with variable 

Touch here 

to expand or 

collapse the 

folders 

section 

Touch here to expand or 

collapse the preview 
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information.  Use the message preview to confirm the message to be printed, then touch Print. The software will automatically go to the 
HOME screen. 
 

 

 

 

 

 

 

 

 

 

HOME Screen  
(inside hamburger menu) 

 

 

 

 

• Touching print will prompt the operator for variables or counts or other fields that are required to print the message properly. 

• From the previous page, the message above is now ready to print. To physically print the printhead needs: 

• Photo-sensor input 

• Encoder speed signal (if the encoder is set to internal, this is not needed)   
 

• Touch Select to print a different message.  
 

• The Count (now at 154) represents the total number of prints for that message. This can be reset by pressing the refresh button next to it. 
 

• Note the GREEN status indicators. When both are green, the system will print when a photo-sensor and encoder speed signal are supplied. 

HOME SCREEN 

printer(s) now connected 
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Line State 

 
Connection  
Indicator 

 

Printing State Status Indicator 

Line connected 
 
 
 

Printing 
 

 

Line connection failed 

 
 
 

Unknown due to no 
printer connection 

 

 
Line connection time-

out 
 

 

Warning 
 

 
Line state unknown  

 

 
Error 

 

Control status 

indicators 
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STATUS Screen (inside hamburger menu) 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Informative, near real-time screen that reports on printer: 

o Connection status. 

o Error conditions and removal of error conditions once they are resolved. 

o Encoder line speed. 

o Product Detect – will toggle green when triggered. 

o Cartridge Ink Level (% full). 

o Printer At Temperature indicator – will not print when not at temperature. 

o Head Type is identified automatically.   

o Missing ink cartridge and more… 

 

• This screen is helpful when troubleshooting.  

 



 
400463 Rev C Software Manual                                                         P a g e  34 

 

 

 

 

 

 

 

 

• Auto Clean function can perform an automatic cleaning cycle on every printer when set to either Interval or Schedule cleaning cycles. It 

is by default active but may be disabled although this is not recommended. 
o NOTE: When entering a time for scheduled maintenance, the value must be entered using a 24-hour clock. The software will 

auto-convert to AM/PM when saved.  

• Save any changes before exiting. 

 

 

 

 

 

 

• Firmware Update  
• Firmware is upgradeable to enhance features. (Contact Technical Support for the latest Firmware version).  

• It is recommended that all printers have the most recent and matching firmware. 

• Consult the Firmware Update screen during troubleshooting operations to confirm the latest software and firmware versions. 

 

MAINTENANCE Screen 
(inside hamburger menu) 
 

SYSTEM Screen 
(inside hamburger menu) 
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• The USB drive will have a new file on it called: Update.bbg. (Contact Technical Support). 

• Insert the Firmware USB into the rear, capped USB port (raise the flap). 

• Open Control, touch System and Firmware Update. Pick the new firmware version then touch the Update button (top-right image above) 

• Backup & Restore will ensure all messages and the current setup remains intact. 

• All firmware updates to the primary are automatically copied to all secondary printers. 

 

 

 

 

 

 

 

 

 

 

 

 

Capped  

USB port 

Wired Network  
Shows network settings of wired network interface 
located near the printer’s waste module. This 
interface is typically used to connect to the 
customer’s network using ethernet. Network 
settings can be obtained automatically (via DHCP) 
or with static settings. 
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Currently connected 

 

Cannot be located by Control 

 

Connection pending 

 

(Blank) Primary printers yet to be connected 

 

Wireless Network  
Shows network settings of wireless network 
interface. This interface is typically used to connect 
to the customer’s network using Wi-Fi. Network 
settings can be obtained automatically (via DHCP) 
or with static settings.  

The HMI can be configured to 
connect wirelessly to a customer’s 
network or directly to a primary 
printer’s access point.  

Wireless Access Point 
The printhead SSID is equivalent to the ID on the 
rear of the printer. 

The default password is: “password”. 
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Custom Codes – Shift Codes 
Allows the user to change the time and codes for 
up to 4 shifts. Save any changes. 

 

Custom Codes – User Codes 
Allows the user to change the user codes for any of the 
available time options which are: 

Minutes, Hours, Quarter Hours, Days of the Week, 
Weeks, Days of the Month, Months and Years.  

Save any changes. 

 



 
400463 Rev C Software Manual                                                         P a g e  38 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Date & Time 
Shows the Local System, Production Line Setup 

(primary printer) and the Rollover Offset 

Local System date & time is the same as the HMI (if 

used). 

The Print Line Setup can be customized to use a 24 

hour clock and/or synced to the Local System. 

Rollover Offset can be customized from default 12:00 

midnight in positive or negative increments but must be 

saved. Upon saving, the Current Rollover Time will be 

updated.  

Negative rollover values entered into the “Hours offset 
from midnight” and “Minutes offset from midnight” will 
print the current date and rollover to the next day at the 
“Current Rollover Time” value.  

Positive rollover values will print the previous day and 

rollover to the current day.  

Time fields are not affected by Rollover Offset.  

 

Inputs & Outputs 
This screen is only active after purchasing the I/O 

Accessory Kit (400006) and configured following the 

instruction sheet in that kit (400006N). 
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Message Look Up  
Requires additional hardware to allow a simple barcode scan to auto-populate new messages.  

o Scanner Kit (Part No. 2465-191). Carefully follow the instruction sheet within this kit.  
o I/O Hub Kit (Part No. 400006). Carefully follow the instruction sheet within this kit. 
o First create a barcode scan sheet. Each barcode name must be equivalent to the message name.   
o The messages MUST reside in the root folder of the primary printer “/”.  
o Scanning the barcode on the scan sheet will auto-populate the next message to be printed on-the-fly. 
 

o External input is used when a printing message contains variable fields with a data source corresponding to the serial port used. The 
data from the serial port will be printed in the location of that field on the next photocell trip.  

Serial Ports 
o COM Port Functions are: None (default), Command & 

Control, Message Lookup & External Input  

o Command & Control allows the execution of a script on 
the controller. Arguments to the scripts are defined 
similar to URL arguments that are passed to the web 
server. 
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Adding Secondary Printers 
 

• Navigate to the Control, Setup tab and click the “+” on the primary printer card.  

• Automatically or manually add 1 to 7 secondary printers per Zone (per primary printer). 

• All printers other than the primary are considered secondary. 

• Match the physical setup to the Control setup and Create message being printed: 

o The distance between the single primary printer photo-sensor to the centerline of each additional printer. 

o The secondary printers in Control setup are dragged to the correct side of the conveyor. 

o Match each print area in the message to the printer.  

o Printers can print the same print area or different print areas of the message. 
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Bundling Messages (Inside the ellipse menu) 
• Message bundling generates a single “.zip” file that contains all resources including messages, graphics, fonts and databases (if applicable). 

This makes it easy to import/export across different systems. Bundles can be created and imported using the same process in Create or 
Control. 

• From the ellipse menu, select Create Bundle. A message bundle source can be either from the Local PC or a Line and may contain individual 
message files and/or folders containing several messages. 

 

• Add files and/or folders to the bundle and touch Next in the bottom right-hand corner. Choose the desired location of the “.zip” bundled file 
on the Local PC and name the bundled file. 

 

• A Package Summary window reports on the resources found that make up the messages including the messages themselves.  
 

o During the bundling process resources may be missing or skipped.  

o A resource is deemed missing if it is referenced in a message but can no longer be found on the system.  
o A file is skipped if it is not in a valid format that can be bundled. 

 

• Upgrading PRD Messages: Messages that were saved with a “.prd” extension may be bundled but undergo a conversion process that upgrades 
them to “.next” extensions so they may be used in Create & Control Software. All upgraded messages should be reviewed prior to printing. 

 

Click to Add files 

Click to Add folders 
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• From the ellipse menu, select Import Bundle. This will open a dialog that lets the user pick a bundle “.zip” file from their local PC. This 
bundle can be imported to the local PC or Line where they may be saved to new or existing folders. 

Bump Turn (Multi-Zone) Configurations 
• Bump turn applications are standard but require advanced knowledge of the Create/Control software. Instructions are provided in a separate 

document 400577.  
 

Database (Inside the Create ellipse menu) 
 

• Add Database Connection 

On the File menu tab in Create, touch Databases. This will open dialog that lets the user choose a database type from the list of supported 
types. Select a type, then click next to proceed. The database details dialog requires the user to enter a connection name. Depending on the 
database type chosen, additional parameters may be required to create a new connection.  

• Add Data Set 

After adding a database connection touch Add Data Set. This will open a dialog that lets the user tell the system if their data set contains 
message locations. Click the Simple button to proceed.  

On the next dialog, select the desired data table from the database. This table will provide data to 
Create & Control. Select data columns that will be used to populate a message. Next, select display columns which will be used to display data 
for row selection then name the dataset. 
 
Pick a row that contains the desired message. To print the message, the message name should be a path to where it is located on the printer: 
messages in the root directory require no “/” character while messages in a folder inside of the prds directory require the “/” character, i.e. 
test/example.next. The application will alert the user when the system does not find a message on the printer. 

• Printing Database variables 

Selecting a message containing a database variable will open a dialog that lets the user select a database row to populate the variable data. This 
dialog also gives the user the ability to search the database based on a column and search text. If the message being printed contains variables 
from multiple different databases, the user populates variables on a per database basis. A dialog will pop up for each database being referenced 
in a variable in the message. 
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• Start Database Message 

On the Messages tab in Control. Refers to databases that contain a message location column, they are referred to as Message Source Datasets. If 
the user created a Message Source Dataset in Create, clicking the select button on the home screen will pop open a dialog; alternatively, this 
same dialog can be opened on the messages page by clicking the Start Dataset Message button. The dialog shows a list of Message Source 
Datasets. 

• Message Databases 

The basic database function has the user choose the template, then a SKU number for example and populates the data into a template. 
 
When creating a dataset, if the database being used contains a column with names of the messages stored on the printer, then the user should 
check the Message Location check box. An additional dialog lets the user select the column that contains the message location.  

Once the data set has been created, if the user adds a variable to a message that references that data set, Control will enable Start Dataset 
Message mode when selecting a message to print from the Home page. This means that the any time the user clicks the Select button on the 
Home page, a dialog will open that lets the user pick a dataset. 

• Variable Database Fields 

Database variables let the user select a data set from the list of available data sets, a data column from that data set, and a default value. 
When printing a message containing this variable type in Control, the user will be prompted to select a database row to populate the data on a 
per dataset basis. 

 

Regional Settings 
• Default language is English, and units are Imperial. 

• The software reflects Microsoft Windows regional settings. This means that if Windows language is set to German and the units are set to 

metric, the interactive pop-up keyboard is German and distances for message fields are in millimeters and centimeters. 
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User Access (Security) 
• Click on the waffle grid icon in the System Preferences ten-times to add a hidden selection: User Access. 

• Enabling an Authentication Mode prompts for a global password to be set to make limit user access in Control. 

• Close and restart Control for the changes to take effect. 

• The user is restricted to the Home, Status and Messages screens. Click Login inside the ellipse menu to temporarily enable full access. 

• Click Login inside the ellipse menu to temporarily enable full access. 

 

Ellipse Menu 

Click Login inside the ellipse menu and enter the 
password to temporarily enable full software access. 

Click here 10 

times 


